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1.0 Approval Sign-Off Sheet  

I certify that I have read and approve DAQ-03-004.2 Standard Operating Procedures for the Thermo 
Ultimate 3000 Ultra High-Performance Liquid Chromatography by Ultra-Violet Radiation and Mass 
Spectrometry (UAT and PAMS Carbonyl Analyses) written here with an effective date of June 29, 2021. 

Director, Air Quality Division  

Michael Abraczinskas 

Signature:         Date:      

Ambient Monitoring Section Chief  

Patrick Butler 

Signature:         Date:      

Laboratory Analysis Branch Supervisor  

Jim Bowyer, Environmental Program Supervisor 

Signature:         Date:      

Projects and Procedures Branch Supervisor  

Joette Steger, Environmental Program Supervisor 

Signature:         Date:      

Primary SOP Author 

Chaitali Bhaumik, Chemist I 

Signature:         Date:      

EPA Region 4 

Designated Approving Official 

Signature:         Date:      
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individuals in the operation of the instrument, related to the North Carolina Division of Air Quality’s 
Ambient Monitoring Program  
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SOP Acronym Glossary 

ACS – American Chemical Society 

AQS - Air Quality System (EPA's Air database) 

CFR – Code of Federal Regulations 

COC – Chain of Custody 

CV – Coefficient of Variation 

DAQ - North Carolina Division of Air Quality 

°C - degrees Celsius 

DNPH - Dinitrophenylhydrazine 

EPA – United States Environmental Protection Agency 

FB – Field Blank 

g – gram  

HPLC – high performance liquid chromatography 

IR - infrared 

≤ - less than or equal to 

L – Liter 

L/min – liters per minute 

MDL – Method detection limit 

mg - milligram 

mL- milliliter 

mL/min – milliliters per minute 

mM - millimolar 

mm Hg – millimeters of mercury 

MS – mass spectrometer 

NIST – National Institute of Standards and Technology 

PM – Particulate matter 

PAMS – Photochemical Assessment Monitoring Station 
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PPB – Projects and Procedures Branch 

PPE – Personal protective equipment 

PTFE – Polytetrafluoroethylene 

QA – Quality assurance 

QA/QC - Quality assurance/quality control 

QAPP - Quality assurance project plan 

QC – Quality control 

RCL – Reedy Creek Laboratory 

RCO – Raleigh central office 

RPD – Relative percent difference 

SIF – Carbonyl Cartridge Sample Information Form 

SN – Serial Number 

SOP - Standard operating procedure 

SPE – Solid phase extraction 

TSA - Technical systems audit 

UAT – Urban Air Toxics 

UHPLC – Ultra High-Performance Liquid Chromatography 

UHPLC-UV-MS – Ultra High-Performance Liquid Chromatograph with Ultra-Violet and Mass 
Spectrometer Detectors 

UPS – United Parcel Service 

USB – universal serial bus 

UV – ultra-violet 

µg/mL – micrograms per milliliter 

µL - microliter 

µm – micrometer 

# - number 

± - plus or minus 
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2.0 SCOPE AND PURPOSE 

This standard operating procedure (SOP) describes the process of carbonyl cartridge sample shipping, 
receiving, extraction, analysis, data processing and review using the Ultra High-Performance Liquid 
Chromatograph with Ultra-Violet Radiation Detector and Mass Spectrometer (UHPLC-UV-MS) 
instrumentation.  

 

Figure 1: Thermo Ultra High-Performance Liquid Chromatograph with Ultra-Violet Radiation Detector and 
Mass Spectrometer 

3.0 EQUIPMENT CHECKS AND MATERIALS 

This section describes the equipment materials that are required to complete the steps described in this 
document.  Additional subsections or SOPs will also describe the equipment and materials as needed.   
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3.1 Equipment and Material List 
• Carbonyl Cartridge Sample Information Forms (SIF) 
• Carbonyl Cartridge Chain of Custody Forms (COC) 
• Insulated Shippers and Frozen Ice Packs 
• Ziploc® Bags 
• Infrared (IR) Temperature Monitoring Device 
• Waters dinitrophenylhydrazine (DNPH) Coated Sorbent Cartridges (part# WAT037500) 
• Carbonyl Cartridge Extraction Manifold Worksheet  
• Solid Phase Extraction Manifold 
• Vacuum Pump 
• Sterilized 5-milliliter (mL) Syringes with Luer-Slip Tips 
• Syringe Filters Discs less than or equal to (≤) 0.22-micrometer (µm) Pore Size 
• Polyethylene Disposable Transfer Pipettes 
• 5-mL Volumetric Flasks 
• 1.5-mL Auto-sampler Vials with polytetrafluoroethylene (PTFE) Septa Caps 
• 4-mL Storage Vials with PTFE Lined Caps 
• Carbonyl-free Grade Acetonitrile 
• Optima/High Performance Liquid Chromatography (HPLC)-Grade Water 
• Optima-Grade Methanol 
• American Chemical Society (ACS)-Grade Ammonium Acetate Salt 
• ACS-Grade Glacial Acetic Acid 
• 1 or 2-Liter (L) Glass Mobile Phase Reservoirs 
• 1-L Volumetric flask 
• Restek CARB-1004 Carbonyl standard mix (13 compounds) 
• Calibration Standard and Quality Assurance (QA) Check Standard Check List 
• Thermo Ultimate 3000 Ultra High-Performance Liquid Chromatography (UHPLC) Gradient 

Pump (part# LPG-3400RS) 
• Thermo Ultimate 3000 UHPLC In-Line Degasser 
• Thermo Ultimate 3000 UHPLC Temperature Controlled Autosampler (part# WPS-3000TRS) 
• Thermo Ultimate 3000 UHPLC temperature-controlled column compartment (part# TCC-

3000RS) 
• Thermo Ultimate 3000 UHPLC Diode Array Detector (part# DAD-3000RS) 
• Thermo ISQ EC Single Quadrupole Mass Spectrometer Detector (SN: ISQEC1809014) 
• Peak Scientific Nitrogen Generator (part # NM32LA 110V) 
• Computer Workstation with Chromeleon Software Installed and Connected to UHPLC 

System 
• 10-100-microliter (µL) and 100-1000-µL Pipettes and Tips 
• Analytical Balance 

3.2 Chemical and Material Checks 
This section describes the chemical, material, or equipment checks.   
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3.2.1 Chemicals and Solvents 
Carbonyl-free grade acetonitrile and calibration/quality assurance/quality control (QA/QC) standard 
mixes must be used within the expiration date printed on the certificate of analysis.  Optima grade 
water and methanol are given a two-year expiration date from the date of receipt, recorded on the 
bottle label.  Acids, bases, and salts are given a 10-year expiration date from the date of receipt, 
recorded on the bottle label.  Lot numbers of chemicals and materials used are recorded where 
applicable in lab logbooks, extraction records, and dilution records. 

3.2.2 DNPH carbonyl cartridges 
DNPH carbonyl cartridges must be used within the expiration date printed on the certificate of analysis 
that accompanies each box of cartridges.  Blank Cartridge media must be stored in a dedicated 
refrigerator at 8 degrees Celsius (°C) or below.  Sampled Cartridges must be stored in a different 
refrigerator at 4°C or below.  For each new lot of carbonyl cartridge media, three cartridges per lot or 1 
percent of the lot whichever is larger must be extracted and analyzed to assess background 
contamination of target carbonyl compounds.   

The following compounds must meet concentrations and acceptance limits before field use: 
Formaldehyde ≤ 0.03 micrograms per milliliter (µg/mL); and all other compounds ≤ 0.02 µg/mL to pass.  
If Formaldehyde and/or Acetaldehyde do not meet acceptance limits, the lot must be disqualified for 
field use and returned to the manufacturer for replacement.  

3.3 UHPLC Instrument Module Checks 
1. Visually make sure instrument modules are connected to the instrument computer via Ethernet 

connections.  Instrument modules display a green light next to the word “connected” on the 
instrument module front panel when successfully connected to the instrument computer. 

2. Open Chromeleon using the instrument computer.  Make sure the instrument modules (Pump, 
Sampler, Column oven, ultraviolet (UV), ISQEC, and Nitrogen generator) are connected and display a 
ready status on the instrument computer control screen.  

3. Make sure instrument controller is connected and operating, if not, click on the instrument 
controller icon in the bottom right corner of the computer screen and click start the instrument 
controller. 

4. Verify the mobile phase reservoirs A, B and C are connected to the appropriate tubing of the pump 
degasser.  

5. Make sure column oven module temperature control is on and left switching valve is appropriate 
(Valve 1 is for UV analysis only and Valve 2 is for UV and mass spectrometer [MS] analysis).    

3.4 Support Equipment Checks 
Verify the pipette, balance, and IR-gun are being used before the expiration dates listed on the 
equipment stickers.  Balance and pipette checks are completed quarterly and are explained in more 
detail in Sections 3.4.1 and 3.4.2 below.  IR-guns are replaced with new devices annually or are verified 
annually against a National Institute of Standards and Technology (NIST) standard according to SOP# 
DAQ-13-002.1 (DryWell 3101 Temperature Generator, Electronics and Calibration Branch 
Responsibilities).  Lab refrigerator temperatures are measured with an IR-gun and recorded in lab 
refrigerator logbooks.  Every effort is made to check and record refrigerator temperatures daily, except 
on holidays and weekends.  
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3.4.1 Pipette Verification Checks 
An accurate pipette is one of the most important tools in performing accurate dilutions of calibration 
and QA/QC standard mixes and preparing mobile phases. To maintain a valid work product, the pipettes 
must be verified quarterly. This section describes steps for quarterly pipette verifications.  

Equipment and Materials needed for Pipette verifications: 

• Mechanical Pipettes 
• Pipette Tips 
• Analytical Balance  
• Weighing Container 
• Optima/HPLC-grade water 
• Beaker 
• NIST-Traceable barometer that reads temperature and relative humidity 

Detailed Procedures 

1. In advance of testing, make sure the balance verification is current.  If the balance verification date 
has expired perform a balance verification prior to the pipette verification.   

2. Fill a beaker partially with Optima/HPLC grade water and turn on the balance to warm it up.   
3. Place pipette, pipette tips and a beaker of water in the extraction lab next to balance for about 2 

hours before starting the measurements so they can reach equilibrium with room temperature. 
4. Place small containers with water inside the balance draft chamber, but not in weigh pan chamber, 

to add humidity to the chamber to reduce water evaporation during testing.   
5. If the balance printer is not being utilized, open a blank pipette verification worksheet (DAQ-03-014) 

located on internal network drives here: P:/Toxics/Urban Air toxics/Aldehyde data/Balance and 
Pipette Checks/DAQ-03-014 Pipette Verification worksheet_TEMPLATE.  Also see Appendix A in 
this document for an example of the pipette verification worksheet.  Print the worksheet to record 
measurements.  If a balance printer is being used, a blank copy of the verification form is not 
needed to record measurements.  Instead, the balance printout readings can be transferred by hand 
to a blank electronic copy of the verification form at the completion of the test.   

6. Reference the current room temperature and barometric pressure from the NIST-traceable 
barometer and follow this link to look up the proper z-factor to use for this pipette verification:  
https://www.integra-biosciences.com/sites/default/files/Z-factors-calibration_2017_01_26.pdf 

7. Load the appropriate pipette tip, adjust the pipette to the highest setting of the operating range of 
the pipette.   

8. Place the weighing container on the analytical balance weigh pan. The weighing container should 
not be dry, add some Optima/HPLC-grade water to the weigh container. 

9. Pre-wet the tip by aspirating and dispensing the nominal volume three times. 
10. Aspirate and draw the nominal amount of Optima/HPLC-grade water from the beaker.    
11. Tare the balance.  
12. Dispense the aliquot in the weigh container.  Be sure to dispense along the inner wall of the weigh 

container and finish by withdrawing the tip end along wall of weigh container to remove residual 
liquid. 
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13. Allow balance reading to stabilize, record the mass on the appropriate place in the blank copy of the 
pipette verification worksheet or use the balance printer to record the measurement. 

14. Using the same tip, repeat steps 10 to 13 five consecutive times.   
15. Eject the tip and load a new tip. Adjust the pipette to the lowest setting of the operating range.  Pre-

wet the tip by aspirating and dispensing the nominal volume three times.  Perform the steps 10 to 
13 five more consecutive times. 

16. Transfer the handwritten measurements or the balance printout readings into an electronic copy of 
the pipette verification worksheet.  Make sure all gray fields of the electronic copy of the pipette 
verification worksheet are filled out.  Save the worksheet as “DAQ-03-014 Pipette 
Verification_Serial Number_MMDDYY and store it here: P:\Toxics\Urban Air Toxics\Aldehyde 
Data\Balance and Pipette Checks\Pipette Verifications\ Pipette SN_XXXX on p drive.   

17. Print a copy of the electronic pipette verification form and staple the handwritten verification form 
and/or the balance printout to the printed electronic copy and store them in the designated file 
cabinet in aldehyde lab.   

18. Once measurements are entered, the electronic copy of the verification worksheet will compare the 
measured accuracy and precision against the limits listed in Table 1 below and provide a pass/fail 
status:  

 

Pipette Volume, μL Relative Error 
Nominal Setting Accuracy (%) ≤ CV or Precision (%) ≤ 
10-100 100 2.0 1.0 

10 8.0 3.0 
100-1000 1000 2.0 1.0 

100 8.0 3.0 
Table 1: Pipette Verification Acceptance Criteria 

19. Record the date and status (pass or fail) of the pipette verification in the current extraction logbook 
(Example: Logbook # EXT-01). 

20. If the pipette status passes, then label the pipette with a certification sticker including the 
certification due date which is 3 months from the current verification date.  If it fails repeat the 
pipette verification one more time following steps 1-19 above for confirmation of the failing status.  
If failing status is confirmed remove pipette from service.  Send pipette for calibration/repair or 
replace with new pipette.  Verify new or repaired pipette prior to use.   

3.4.2 Balance Checks 
An accurate analytical balance is a crucial and fundamental piece of equipment for a laboratory for 
precision weighing. To maintain the quality work, the balance must be verified with certified mass(s) 
quarterly. This section describes steps for balance checks.   

Equipment and Materials needed for balance verification. 

• Analytical Balance  
• Certified mass set 
• NIST-Traceable barometer that reads temperature and relative humidity 
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Detailed Procedures 

1. The analytical balance must be verified with certified mass standards. Verify the check masses are 
not past due for calibration.  

2. If a balance printer is not being utilized, open a blank balance verification worksheet (DAQ-03-015) 
located on internal network drives here: P:/Toxics/Urban Air toxics/Aldehyde data/Balance and 
Pipette Checks/DAQ-03-015 Balance Verification Worksheet_TEMPLATE.  Also see Appendix B in 
this document for an example of the balance verification worksheet.  Print out the blank worksheet 
to record measurements.  If the balance printer is being used, a blank copy of the worksheet is not 
needed to record measurements.  Instead, the balance printout readings can be transferred by hand 
to a blank electronic copy of the worksheet at the end of the test. 

3. Verify the balance is level, if leveling adjustment is needed, manipulate the leveling feet so that the 
air bubble is centered within the circle of the balance level indicator.  

4. Turn on the balance. 
5. Press the tare button if needed to zero the balance readings before placing test mass on balance 

weigh pan.  
6. Open balance draft door and place the first test mass in the center of the balance weigh pan.  
7. Close the draft door.  Allow several seconds for a stable mass reading to be displayed. 
8. Record the balance reading on the blank worksheet or record the balance reading using the balance 

printer.  
9. Repeat steps 5-8 for each nominal test mass (5 milligrams [mg], 200mg, 500mg, and 2 grams [g]) 
10. Open a blank balance verification worksheet and save the worksheet as: “DAQ-03-015 Balance 

Verification_Serial Number_MMDDYY and store it here: P:\Toxics\Urban Air Toxics\Aldehyde 
Data\Balance and Pipette Checks\Balance Verifications.    

11. Enter the handwritten measurements and/or balance printout readings in the recently created 
worksheet.  Make sure all gray colored cells are filled out (serial numbers of equipment, room 
environmental conditions, etc.).  The electronic version of the worksheet will calculate a %Diff and 
provide a pass/fail status.  

12. Save the worksheet then print a hard copy.  Staple the handwritten copy and/or the balance 
printout to the printed hard copy.  Store all hard copy records in the designated file cabinet in the 
aldehyde lab.  The electronic file will be stored using the naming convention and storage location 
listed in step #10 above.     

13. Record the balance verification date and pass/fail status in the current balance logbook. 
14. If balance passes, label the balance with a certification sticker including the next verification due 

date (which is 3 months from the current balance verification test date).   
15. If the balance fails, repeat the balance verification check procedure again with a new form to 

confirm the failing status.  
16. If failing status is confirmed, do not use the balance until it is calibrated by the balance 

manufacturer or designated balance calibration service provider.   
17. If the balance passes the confirmation test, label the balance with a certification sticker including 

the next verification due date (which is 3 months from the current balance verification test date).   
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4.0 SITE CHECKS  

This section is reserved.  Site checks do not apply to analysis instruments housed at the Reedy Creek 
Laboratory (RCL). 

5.0 DETAILED PROCEDURES 

This section describes steps for carbonyl cartridge shipping, receiving, extraction, sample analysis, 
instrument data analysis, and data package processing.  

5.1 Shipping Carbonyl Cartridge Samples 
1. Reference the carbonyl sampling schedule located on internal network drive P:\Toxics\Urban Air 

Toxics\Sampling Calendars\Current year Sampling Calendar for Urban Air Toxics (UAT) and 
Photochemical Assessment Monitoring Station (PAMS) sampling to determine when to ship the 
carbonyl samples and what type of carbonyl samples to ship. 

2. Obtain an un-sampled DNPH cartridge from a lot of cartridges that has passed the lot blank test 
from RCL Fridge 1 for all samples needed to be shipped and/or assigned. 

3. Obtain one blank carbonyl cartridge SIF (DAQ-16-009) for each cartridge being shipped and/or 
assigned.  See Appendix C of this document for an example of the carbonyl cartridge SIF. 

4. Obtain an insulated shipper or cooler, frozen icepacks, and Ziploc bags. 
5. Using a black or blue ink pen, circle the sample program, sample type and/or QC sample type (if 

applicable); record the sampling site; record the DNPH cartridge lot number (#); sample #; sample 
channel # and port number [ATEC 8000 only for port number]; and scheduled sample date in the 
Laboratory Setup information section on the carbonyl cartridge SIF.  The scheduled sampling date is 
derived from the sample #.  For example, sample # C020321C indicates a scheduled sample date 
2/3/2021 at the Candor site.   

6. Sample naming examples for UAT carbonyls include: C020321M for UAT Millbrook sample date 
2/3/2021, C020321C for UAT Candor sample date 2/3/2021, C020321MD for UAT Millbrook 
Duplicate sample date 2/3/2021, and C020321MFb for UAT Millbrook field blank sample date 
2/3/2021.   

7. Sample naming examples for PAMS include: PC020321M1 for PAMS Millbrook sample date 
2/3/2021 collected from 04:00 - 12:00, PC020321M2 for PAMS Millbrook sample date 2/3/2021 
collected from 12:00 – 20:00, PC020321M3 for PAMS Millbrook sample date 2/3/2021 collected 
from 20:00 – 04:00(following day), PC020321MFb for PAMS Millbrook field blank sample date 
2/3/2021 on channel # specified on the SIF.  

8. Please see Table 2 for PAMS and UAT carbonyl sample collection times. 

 
PAMS Sample #  

Collection Start Time  
(local standard time)  

Collection End Time  
(local standard time)  

PC020321M1 04:00 12:00 
PC020321M2 12:00 20:00 
PC020321M3 20:00 04:00 (the following day) 
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UAT Sample #  

Collection Start Time  
(local standard time)  

Collection End Time  
(local standard time)  

C020321M 00:00 (midnight) 23:59 or 00:00 (midnight) 
Table 2:  PAMS and UAT Carbonyl Sampling Times 

9. Field blank (FB) samples must be scheduled once per month for UAT and twice per month for PAMS.  
The UAT field blank samples will rotate between the two UAT carbonyl sites (Millbrook and Candor).  
For example, if the UAT FB is scheduled for Millbrook in January, the next UAT FB sample should be 
scheduled for Candor in February.   

10. The UAT and PAMS field blank samples will be assigned a specific sampler channel number and port 
number (typically channel #1 port 1, 2, or 3 for PAMS [ATEC 8000] and channel #1 for UAT [ATEC 
2200]).   

11. Label the carbonyl cartridge foil pouch with the sample # listed on the carbonyl cartridge SIF and 
place the labeled cartridge in a Ziploc bag to protect it from moisture generated by melting ice 
packs. 

12. Tear off the gold bottom copy of the carbonyl cartridge SIF, set aside the gold copy and place the 
remaining carbonyl cartridge SIF in a document sized Ziploc bag to protect it from moisture 
generated by melting ice packs.  Prepare more samples if needed, repeat steps 1-12 above for each 
cartridge being prepared. 

13. Obtain a blank carbonyl cartridge COC form for UAT and PAMS Required sites.  See form example in 
Appendix D.  Fill out the COC form fields, making sure to include all cartridges assigned a site for the 
upcoming sample event. 

14. Review the carbonyl sample SIF and labeled foil pouches against each other and against the 
information in the carbonyl cartridge COC form to be sure all recorded information is accurate.  If no 
edits are required, sign and date the first relinquished by and date/time field on the carbonyl 
cartridge COC form. 

15. Place the labeled foil pouch in the insulated shipper, making every effort to sandwich the foil pouch 
between the ice packs.  Place the filled-out and Ziploc bagged carbonyl sample SIF inside the 
insulated shipper, on top of the ice packs. 

16. Place the filled-out carbonyl cartridge COC form in a document sized Ziploc bag to protect it from 
moisture generated by melting ice packs.  Place the bagged form inside the insulated shipper on top 
of the ice packs. 

17. Gather the gold copies of the carbonyl sample SIF and update the carbonyl sample tracking chart 
excel file.  See Appendix E for UAT Carbonyl sample tracking chart and Appendix F for PAMS 
Carbonyl sample tracking chart.  The tracking chart file is located on internal network drives here: 
P:/Toxics/Urban Air Toxics/VOC Current Year Data/Tracking Chart UAT VOC & Aldehyde.  Enter 
the shipping date for the samples that were prepared and color the cells using the color code on the 
tracking chart file.  

18. After the tracking chart has been updated, place the gold copies of the carbonyl sample SIF forms in 
a properly labeled file folder in the designated file cabinet in the carbonyl laboratory.  These forms 
can be used as reference to confirm sample preparation and shipment to the field. 
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5.2  Receiving Carbonyl Cartridge Samples 
Carbonyl cartridges arrive at the laboratory via hand delivery by the site operator or delivery by United 
Parcel Service (UPS) or designated commercial shipping carrier. 

1. If the sampled cartridges are hand delivered by the sampling site operator after business hours, the 
site operator must store the cooler and samples in a secure, pre-determined storage location at the 
RCL.  This cooler will be received by the UHPLC operator on the following business day.     

2. Check the secure storage location for sampled cartridge coolers hand delivered by the site operator. 
Immediately or as soon as possible open the cooler.   

3. Using a certified IR temperature gun, take the temperature of the carbonyl cartridge foil pouch (the 
operator may have to adjust ice packs to get a clear line of sight to the cartridge foil pouch).   

4. Record this temperature on the carbonyl cartridge SIFs for all sampled cartridges present in the 
insulated shipper. Record the serial number of the IR gun used to measure the temperature. 

5. Sampled cartridges may also be delivered to the lab by UPS or a commercial shipping carrier.  This 
typically occurs during normal business hours.  Immediately or as soon as possible open the cooler.   

6. Using a certified IR temperature gun, take the temperature of the carbonyl cartridge foil pouch (the 
operator may have to adjust ice packs to get a clear line of sight to the cartridge foil pouch).   

7. Record this temperature on the carbonyl cartridge SIFs for all sampled cartridges present in the 
insulated shipper. Record the serial number of the IR gun used to measure the temperature. 

8. Pull out the sampled cartridges, carbonyl cartridge SIF(s), and the carbonyl cartridge COC form.  
Verify the information on the SIF and COC match the information written on the cartridge foil 
pouches and match each other.   

9. Record the signature and date/time in the second received by and date/time fields on the carbonyl 
cartridge COC form.   

10. Verify the information recorded on the carbonyl cartridge SIF.   
11. Contact the site operator with any questions, or if there are illegible entries and/or blank fields on 

the carbonyl cartridge SIF or carbonyl cartridge COC. 
12. Verify the volume and pre- and post-flows written on the carbonyl cartridge SIF form are within the 

acceptable ranges.  Sample volume should be within 1240L to 1650L for UAT samples and 414L to 
550L for PAMS samples.  Sample flow should be 0.9 to 1.1 liters per minute (L/min) for both UAT 
and PAMS samples.   

13. If the volume or flow are not within acceptable ranges, place a note in the comments section on the 
carbonyl cartridge SIF, if a comment was not already recorded by the site operator.    

14. Using a stapler, attached the sampled carbonyl cartridge foil pouch to the corresponding carbonyl 
sample SIF.   

15. Fill out the sample received by; date and time sample received; and store in the aldehyde sample 
refrigerator (RCL Fridge 2) located in the aldehyde laboratory.   

Note:  sampled cartridges must be stored in a different refrigerator from unused cartridges. 

5.3 Extracting Carbonyl Cartridge Samples 
Note:  The extraction process must be completed inside a fume hood located in the extraction lab room 
at the RCL.  Proper personal protective equipment (PPE) including safety glasses must be worn during the 
extraction procedure.  Each extraction batch contains 20 or fewer sample cartridges and must contain at 
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least one cartridge blank (method blank), one cartridge spike (laboratory control sample), and with 
resources permitting one cartridge spike dup (laboratory control sample duplicated) and one cartridge 
method detection limit (MDL) spike.  

Sometimes a sampler needs to be certified as clean when no sampled cartridges are waiting for 
extraction.  In these cases, if three or less sampler certification cartridges are being extracted, at a 
minimum extract one cartridge blank (method blank) and one cartridge spike (laboratory control sample) 
with the sampler certification cartridges. 

1. Retrieve 20 or less sampled cartridges or sampler certification cartridges and the attached SIF(s) 
from the aldehyde sample refrigerator (RCL Fridge 2) located in the aldehyde laboratory.  Set aside. 

2. Retrieve enough additional un-sampled cartridges from the VOC laboratory refrigerator (RCL Fridge 
1) and enough blank SIF(s).  These cartridges will be assigned a QC Sample Type such as cartridge 
blank, MDL spike and cartridge spike.  Include a Cartridge SIF for each QC cartridge being prepared. 

3. Fill out the aldehyde extractions manifold worksheet shown in Appendix G with the samples to be 
extracted. 

4. Record the analyst initials, extraction date, cartridge sample dates, and extraction material lot 
numbers on the extraction manifold worksheet. 

5. Record the extraction date and manifold port number on the carbonyl cartridge SIF(s). 
6. Cap the 4mL storage vials and label them using a permanent marker with the sample # for each 

cartridge being extracted, including QC samples. 
7. Cap the 1.5 mL auto-sampler vials and label them with the sample name for each cartridge being 

extracted, including QC samples. 
8. Clean the solid phase extraction (SPE) manifold using the carbonyl-free acetonitrile by opening each 

port valve and rinsing acetonitrile through the manifolds’ flow path, including the outside surfaces 
of the needle guides. Close the valve of each port. Set aside in the fume hood. 

9. Rinse 5mL volumetric flasks using carbonyl-free acetonitrile.  Wash each 5mL volumetric flask at 
least 3 times and place each cleaned flask on the rack.  Place the rack containing the washed flasks 
inside the vacuum chamber of the SPE manifold. 

10. Place the cleaned manifold on top of the vacuum chamber.  Ensure the needle guides for each SPE 
site are inserted into the 5mL volumetric flasks.  If any needle guides are not lined up, the extract 
will be lost.  Make sure the screw caps of the manifold are closed tightly. 

11. Referencing the extraction manifold map show in Appendix H, place cartridge spike samples and/or 
MDL spike samples on the assigned port using a slight twist to lock the Luer tip of the cartridge to 
the manifold. 

12. Open the valve slightly, about a half turn. Turn on the pump to apply a vacuum on the cartridges to 
be spiked. 

13. Spike the amount of standard as per the DAQ-03-017 Carbonyl Calibration and QC Standard 
Dilutions Checklist located on internal network drive P:\Toxics\Urban Air Toxics\Aldehyde 
Data\Carbonyl Standard Dilution Chart for making calibration and QA check standards using the 
appropriate pipette and pipette tip. 

14. Release the vacuum and close the manifold valves. 
15. Referencing the extraction manifold worksheet Appendix G and the manifold map Appendix H 

Install the remaining blank and sample cartridges on the vacuum manifold. 
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16. Remove the plunger from the 5mL syringe and set aside. Place the 5mL syringe into the cartridge 
inlet and use a slight twist to lock the syringe onto the cartridge inlet. 

17. Dispense approximately 4.5 mL of acetonitrile into each 5mL syringe.  Carefully loosen the screw 
caps of the manifold to allow acetonitrile to flow out of the syringe and through the cartridge. The 
acetonitrile will continue down through the needle guides and into corresponding 5mL volumetric 
flask. 

18. Apply a slight vacuum to the extraction manifold using the attached vacuum pump.  Do not exceed -
10 millimeters of mercury (mm Hg).  Applying a vacuum to the system will assist in forcing the 
acetonitrile through the cartridge. 

19. Once the acetonitrile has been collected in the 5mL volumetric flasks, turn off the pump and release 
the vacuum on the system. 

20. Carefully remove the rack containing the 5mL volumetric flasks from the vacuum chamber, be sure 
to not spill any extracts.  If a spill occurs the sample must be invalidated as a lab error and the 
invalidation noted on the SIF form. 

21. Using the same syringe during the extraction, attach a syringe filter to the syringe tip using a slight 
twist motion to lock the filter to the syringe tip.  Carefully place the syringe and filter into the correct 
4mL storage vial that has been previously labeled with the sample # and extraction date. 

22. Using disposable pipettes, bring the volume of the 5mL volumetric flask to the mark with carbonyl 
free acetonitrile. 

23. Mix the extract in the 5mL volumetric flask several times using the same disposable pipette. 
24. Transfer the extract into the 5mL syringe with attached filter.   
25. Carefully replace the plunger of the syringe and force approximately 2mL of extract into the 4mL 

storage vial.   
26. Stop the plunger, and force approximately 1mL of extract into the 1.5 mL auto-sampler vial.   
27. Finally, force the remaining extract into the 4mL storage vial.   
28. Cap each vial and set aside.  
29. Store extracts in the sample refrigerator of the aldehyde laboratory (RCL Refrigerator 2).  Extracts 

must be analyzed within 30 days of the extraction date. 
5.4 Carbonyl Sample Analysis 
1. Prepare mobile phases to be used during aldehyde analysis.  Mobile phase A is a 2 millimolar (mM) 

ammonium acetate solution.  This mobile phase needs to be made fresh before each run to 
minimize bacteria growth. If needed, mobile phase A can be filtered in a vacuum filtration assembly. 
This solution should be removed from the system after completion of the analytical run and the 
mobile phase lines should be flushed with a solvent/pure water mixture (80:20 water/methanol). 

2. Obtain a 1L volumetric flask.  Rinse the flask several times, in order, using Optima/HPLC-grade 
water, then methanol and then finally carbonyl-free acetonitrile.  

3. Partially fill the flask with Optima/HPLC-grade water.     
4. Weigh out 144 ± 8mg of ammonium acetate salt.  Transfer the ammonium acetate salt into the 1L 

volumetric flask.   
5. Pipette 57 ± 3 µL of glacial acetic acid and dispense into the 1L volumetric flask containing the 

ammonium acetate salt.  Dilute to the 1L mark with Optima/HPLC- grade water, mix the solution by 
inverting the 1L volumetric flask several times. 

6. Transfer the 2mM ammonium acetate buffer solution into a clean, empty UHPLC reservoir and 
sonicate/degas for at least 30 minutes (also mobile phase A can be degassed during the filtration 
processes).   
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7. Connect this mobile phase reservoir to channel A of the UHPLC system solvent rack. This solution 
can also be made directly in a clean, measured 1L UHPLC reservoir. 

8. Mobile Phase B is 100% carbonyl-free grade acetonitrile.  The solvent is submicron filtered by the 
manufacturer.  Do not filter the acetonitrile as filtering may introduce contamination.   

9. Dispense carbonyl free grade acetonitrile into a clean, empty UHPLC reservoir and attached this 
reservoir to Channel B of the UHPLC system solvent rack.   

10. Do not add fresh solvent to reservoirs A and B which contain existing solvent.  Completely empty the 
reservoirs of solvents before dispensing fresh solvents in the reservoirs.  Best lab practice is to rinse 
the reservoir three times with the corresponding solution prior to fill. 

11. Mobile Phase C is approximately an 80:20-mixture of Optima/HPLC- grade water and Optima-grade 
methanol, respectively.  This mobile phase is used to flush the system of built-up ammonium 
acetate salts after analysis is complete.  Rinse the C reservoir with Optima/HPLC-grade water.   

12. Fill the reservoir with approximately 800 mL of Optima/HPLC-grade water, then add Optima-grade 
methanol until there is 1000 mL of liquid in the reservoir. This solution should be 
sonicated/degassed to remove dissolved gas bubbles.  

13. Attach this reservoir to Channel C of the UHPLC system solvent rack.  For this reservoir, the analyst 
can add fresh mobile phase to older mobile phase since this solvent is used for flushing purposes 
only. 

14. Power up the UHPLC-ISQEC system modules and the system computer.  Open the Chromeleon 
software and ensure each module is detected by the software and can be controlled using the 
computer.  

15. In Chromeleon, make sure all the system modules are connected. Open the commands dialog box 
for the pump to purge the mobile phases A, B and C. Set the channel to be purged to 100% of each 
line.  

16. Open the purge valve on the purge unit of the pump (rotate the knob counterclockwise). Start the 
purge cycle according to the selected settings. To do so, set Purge to on and follow the prompt. 
When specified purge time has elapsed, purge is automatically reset to off. Purge can be stopped 
manually, if needed, by setting purge to off.   

17. Repeat the above steps for all channels until the air bubbles are gone.  For the last few minutes, 
flush with the analytical starting conditions of 52%A/48%B/0%C.  After completion close the purge 
valve.  

18. Change the pump flow to 0.4 mL/min. Allow 30-60 minutes of equilibration time. Then record the 
system backpressure in the logbook. 

19. In Chromeleon, open the commands dialog box for the auto-sampler. Under sampler, click on prime 
syringe and wash buffer loop to help remove any air bubbles or debris trapped in the auto-sampler 
syringe. 

20. In Chromeleon, open the commands dialog box for the column oven. Make sure column 
temperature control is on. Enter the appropriate switching valve on the left side of the instrument; 
Valve 1 is for only UV analysis and Valve 2 is for UV and MS analysis. 

21. In Chromeleon, open the commands dialog box for the detector. Set VIS lamp on to turn on the 
tungsten lamp. Then set UV lamp on to turn on the deuterium lamp.  

22. In Chromeleon, open the commands dialog box for the ISQ-EC. Start real time scanner using the 
parameters listed in Appendix I to full scan the mobile phase. If scanning indicates the presence of 
mobile phase, then stop the real time scanner. If contamination is indicated, flush the system for a 
longer amount of time to purge contaminants or investigate the source (e.g., contaminated 
acetonitrile solvent). 
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23. Set the data acquisition to on in the detector dialog box and monitor the detector baseline. Allow 
the system to equilibrate for at least 60 minutes prior to start of analysis. System can also be 
equilibrated using the smart startup functions of the instrument control software. 

24. While the system is equilibrating, prepare the calibration and QC standards as per the “DAQ-03-017 
Carbonyl Calibration and QC Standard Dilutions Checklist” located on internal network drive 
P:\Toxics\Urban Air Toxics\Aldehyde Data\Carbonyl Standard Dilution Chart, shown in Appendix J, 
using the appropriate pipette and pipette tip.  The system can be calibrated before each analytical 
run at analyst discretion.  The calibration standards need to be prepared fresh prior to executing a 
calibration on any analytical run. When using a previous calibration curve, all check standards and 
blanks must pass the prescribed criteria in Table 3. 

25. Prepare the sample sequence by entering each standard and sample to be analyzed. Current run 
sequence can be made by copying an earlier run or click on file and create sequence. When copying 
the earlier run, in Chromeleon, click on data select one of the earlier runs, file, save as the sequence 
in the current run folder (by year) using this format: MMDDYY_Aldehyde_Run_UV (e.g., 
021721_Aldehyde Run_UV).  

26. Edit all standards and samples to be analyzed.  Verify the sample name entered in the sequence 
match the sample location on the auto-sampler vial tray.  An example sequence is shown in 
Appendix K for UV analysis and Appendix L for MS analysis.  The sample sequence must contain the 
current instrument method and current data processing method used for analysis.  Make sure to 
Save the current sequence. 

27. Pull out the sample extracts from the aldehyde sample refrigerator (RCL Fridge 2) to be analyzed.  
Place the auto-sampler vials in the correct auto-sampler tray locations based on the sequence 
created.   

28. With each sequence, a duplicate injection must be completed, and a reanalysis of a sample from the 
last run must be analyzed.  The reanalysis injection is indicated by this format: C020321CR (for a 
repeat analysis from a previous run).   

29. The duplicate injection is indicated by this format: C020321CS (duplicate injection analysis of a 
sample from same sequence).   

30. After system equilibration is complete and the sequence has been saved, turn off the data 
acquisition. Then open the Queue tab on the UHPLC system control software.  Click Add and select 
the sequence to be analyzed.  Click ready check and the system will diagnose the sequence for any 
errors.  If errors are found, correct, and redo this step. Click on the smart shutdown tab to 
automatically shut down the system after finishing the sequence.     

31. It is very important to verify the auto-sampler vial location against the list in the sample sequence; 
the software will not find errors associated with vials in the wrong locations.  If no errors are found, 
press Start to execute the sequence. 

32. If the calibration curve passes criteria and the sequence finished, additional samples may be 
analyzed under the same calibration curve.  The additional samples must be bracketed by solvent 
blanks and QC checks.  

33. If a target compound concentration exceeds the calibration curve range, the sample extract can be 
diluted and re-analyzed, and diluted results are reported only for compounds exceeding calibration 
range.     
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5.5 Carbonyl Data Analysis  
Once the run is complete, data analysis can begin. MS raw data must be saved before processing the UV 
data. 

5.5.1 MS Detector Data Processing 
NOTE:  MS data results are not reported to AQS.  The MS results are being used for informational 
purposes only. 

1. In Chromeleon Open data, select current sequence (e.g., 021721_Aldehyde Run_UV).  
2. Click file, save as with raw data for MS (e.g., 021721_Aldehyde Run_MS).  
3. Open the MS run sequence, update the current processing method, change the calibration levels 

from level 0 to level 3 (conc.0.003 ug/ml to 1.00 ug/ml) and save.   
4. Double click the chromatogram of Calibration level 2, Click on MS Quantitation channel, go to 

processing tab, adjust the retention time of all the compounds, if needed, in the component table.   
5. In the data processing tab, check all the chromatograms of the sequence and make sure all the 

compounds are identified correctly. Data Processing →MS Component → Smart link.  After making 
those adjustments save the processing method. 

6. Print out the MS data, calibration, amount summary and sequence.  For example, Report Designer 
→Integration Tab → File → Print → Current Sequence → Unchecked all but Integration →OK. 
Before printing out make sure the current report template has been selected and the current run 
folder has been created in the instrument computer desktop. Export data files under the current 
year MS data. 

7. Once all chromatograms of the sequence have been checked by the analyst, data needs to be 
exported into the network drive. 

8. First export integration of all injections of the current analysis. Report Designer → File → Export → 
Current Sequence → Parent Folder Desktop → Data Export →Year → Select MS Data →Current 
Run folder → OK →check PDF and /or Excel → Setting (Tool Symbol) → check only Integration → 
File name Formula (Current Run Date_ Aldehyde Run_MS_ Integration) → Ok. 

9. Similarly, export the Calibration, Sequence, Amount Summary for current injection under the 
current run folder. Report Designer → Required Tab (Ex. Calibration) → File → Export → Current 
Injection → Parent Folder Desktop → Data Export → Year → Select MS Data → Current Run Folder 
→ OK →Uncheck PDF and Check Excel → Setting (Tool Symbol) → check only Calibration → File 
name Formula (Current Run Date_ Aldehyde Run_MS_ Calibration) → OK 

10. The data need to be copied into the network P drive under current year MS Aldehyde data via an 
external hard drive. 

11. After data have been saved in the P drive, open Amount Summary of the current MS run folder and 
convert all n.a. to 0.000 and then save it.  Then Complete the current year carbonyl master 
spreadsheet with all data copied from amount summary report of MS data into the Carbonyls-MS 
ug_mL tab. 

 
5.5.2 UV Detector Data Processing 
1. In the UV run sequence, double click the chromatogram of Calibration level 3 or 4. Click on 

processing method and select acetaldehyde peak. In the Peak Group table, compare the peak group 
start and end time with the current acetaldehyde peak group start and end time and adjust if 
needed. 
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2. Then adjust the retention time of all the compounds in the component table. After making those 
adjustments save the processing method. Export the raw data and print out all raw data 
chromatograms prior to making any manual adjustments to individual chromatograms. Make sure 
to use current report template and current run folder has been created in the instrument computer 
desktop. Export data file under current year UV data. Report Designer→ Integration Tab → File → 
Print → Current Sequence → Unchecked all but Integration → OK  

3. The integration software tends to find many unknown peaks (especially in summer) and tends to 
draw baselines in the wrong areas.  It is common to manually adjust the integration software for 
each injection in a run. Most samples contain unknown peaks that elute near the known reference 
standards.  Adjusting baselines and splitting peaks is a common data analysis process for each 
sample analyzed. Appendix M shows an unedited chromatogram and Appendix N shows the same 
chromatogram manually adjusted. 

4. Make sure the chromatogram is saved after any manual adjustments are made.  To remove manual 
adjustments, click the processing tab and click remove manual adjustments.  This will return the 
chromatogram to its raw format.   

5. Once all chromatograms of the sequence have been checked and/or manually adjusted by the 
analyst, print out the integration of all the chromatograms. Also print out the calibration curve, 
Sequence (Overview) and amount summary of the current run folder.  Report Designer → Required 
Tab (Ex. Calibration) → File → Print → Current Injection→ Unchecked all but Calibration →OK. 

6. Current data needs to be exported into the network drive after each run to complete the QA 
summary report. First export integration of all injections of the current analysis onto a universal 
serial bus (USB) storage device. Report Designer → Integration tab →File → Export → Current 
Sequence → Parent Folder Desktop → Data Export →Year → Select UV Data → Current Run Folder 
→ OK →check PDF and/or Excel → Setting (Tool Symbol) → check only Integration → File name 
Formula (Current Run Date_ Aldehyde Run_UV_ Integration) → OK 

7. Similarly, export Calibration, Sequence, and Amount Summary for current injection under the 
current run folder onto a USB storage device. Report Designer → Required Tab (Ex. Calibration) → 
File → Export → Current Injection → Parent Folder Desktop → Data Export → Year → Select UV 
Data → Current Run Folder → OK →Uncheck PDF and Check Excel → Setting (Tool Symbol) → 
check only Calibration → File name Formula (Current Run Date_ Aldehyde Run _UV_Calibration) 
→ OK 

8. These data files need to be stored on internal network drives for further review.  Transfer the 
exported instrument files to the proper location on internal network servers under current year’s UV 
Aldehyde data via an external USB hard drive. 

9. Open a blank QA summary report (DAQ-03-016).  Save this file with new name.  See Section 7.7 for 
details on naming and storage conventions.    

10. Record the current run folder name in the QA Summary report   
11. Open the Amount Summary of the current run folder and record the current run folder name.   
12. Convert all n.a. to 0.000 and save it. Fill up the QA summary report for each criterion by copy and 

paste from the amount summary.    
13. Add sampler information form data and instrument data to the current year’s Carbonyl Master 

Spreadsheet (DAQ-03-012) by copy and paste from the Amount Summary Reports or hand entered 
from the SIFs.  See Section 7.5 for details on naming and storage conventions.  

14. Add data to the QA summary report from the Carbonyl Master Spreadsheet where applicable.  
15. Print out the completed QA summary report and add the printed copy in the aldehyde run folder.  
16. Complete the Level 1 data review checklist (see Section 6.1) 
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17. Once the level 1 data review is completed, notify the level 2 reviewer via email or by verbal contact. 
The hard copy and electronic copy of the data packet must include paper copies of all the 
documents mentioned in the UAT and PAMS Carbonyl Sampling and Analysis Data Level 1/Level 2 
Review Checklist. 

5.5.3 UHPLC Data Validation Parameters and Flags 
See Table 3 below for a list of UHPLC data validation parameters, acceptance criteria, and applicable 
AQS qualifier and null codes.  Solvent blanks are analyzed at the beginning of the sequence, after the 
initial calibration curve, and with each check standard injection.      

QA 
Summary 

Report 
Flag 

Where the flag comes 
from? Acceptance Criteria AQS Code 

1a Solvent Blank All compounds ≤ MDLspk to pass. QA Qualifier: LB 

 *Extraction Solvent  
Method Blank All compounds ≤ MDLspk to pass. QA Qualifier: LB 

2a Cartridge Blank 
analysis results All compounds ≤ MDL to pass. QA Qualifier: LB 

2b Field Blank analysis 
results 

Formaldehyde ≤ 0.06 µg/mL Acetone ≤ 0.15 
ug/mL; Acetaldehyde ≤ 0.08 µg/mL; Sum of 
All other ≤ 1.4 µg/mL. 

QA Qualifier: FB 

 **Trip Blank analysis 
results 

Formaldehyde ≤ 0.03 µg/mL; Acetone ≤ 0.06 
µg/mL; and all others ≤ 0.02 µg/mL to pass.  

 Lot Blank Analysis 
Formaldehyde ≤ 0.03 µg/mL; Acetaldehyde ≤ 
0.02 µg/mL; Acetone ≤ 0.06 µg/mL; and all 
others ≤ 0.02 µg/mL to pass. 

QA Qualifier: LB 

3a Calibration Curve Calibration Type: Linear with offset.  If the 
correlation coefficient is less than <0.999  Null: AT 

3b Calibration Curve 
Relative percent difference (RPD) for each 
calibration level against the nominal 
concentration must be ≤20%.   

Null: AT 

3c Calibration Curve The absolute value of calibration curve 
(offset/slope) must be ≤ current MDLspk. 

Null: AT 

4 HL-QA analysis results 
The RPD of each compound in the HL-QA 
against the nominal concentration must be ≤ 
15%.   

Null: AS 

5 
Replicate analysis 
(duplicate injection 
results) 

The RPD for each compound detected ≥ 
0.1ug/mL must be ≤ 10%. Flag compounds 5 
and qualify results QX before reporting to 
AQS. 

QA Qualifier: 4 

6a Sampled Cartridge 
hold time 

The (extraction date – sample date) must be 
≤ 14 days.  QA Qualifier: HT 

6b Sample Extract hold 
time 

The (analysis date – extraction date) must be 
≤ 30 days.  QA Qualifier: HT 
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QA 
Summary 

Report 
Flag 

Where the flag comes 
from? Acceptance Criteria AQS Code 

QX 
Cartridge Spike 
Recovery and 
Precision 

Cartridge spike recovery RPD against nominal 
± 20% (formaldehyde); ± 30% (all other 
compounds).  Cartridge spike/cartridge spike 
duplicate RPD ≤ 20%.   

QA Qualifier: QX 

 Sample receipt 
temperature 

The sampled cartridge receipt temperature 
must be ≤ 4°C.   QA Qualifier: TT 

 
Collocated/Duplicate 
sample collection 
analysis results 

The RPD for each compound detected ≥ 
0.1ug/mL must be ≤ 20%.   QA Qualifier: 3 

 DNPH peak area 
analysis 

The DNPH peak area found in samples must 
be ≥ 50% of the average DNPH peak area 
from lab blanks and cartridge spikes. 

QA Qualifier: DN 

Table 3: UHPLC Data Validation Parameters and Acceptance Criteria 

*Extraction Solvent Method Blanks are not performed regularly.  Instead, this QC sample is used as part 
of corrective action investigations to find sources of contamination in the event of systemic cartridge 
blank failures of priority compounds (Formaldehyde and Acetaldehyde).   

**Trip blanks are not performed regularly.  Instead, this QC sample is used as part of the corrective 
action investigations to find sources of contamination in the event of the systemic field blank failures of 
priority compounds (Formaldehyde and Acetaldehyde). 

6.0 CARBONYL DATA REVIEW  

This section of the SOP describes steps required for the primary lab staff to perform a self/Level 1 data 
review and a trained lab staff not directly involved in the carbonyl collection or analysis method to 
perform a peer/Level 2 data review on the carbonyl sampling and analysis data. 

6.1 Level 1 Carbonyl Sampling and Analysis Data Review 
1. After the primary analyst finishes preparing the analytical batch, the primary analyst performs a 

self/Level 1 review of the analytical batch. 
2. Open a blank data review checklist located on internal network drives here: P:\Toxics\Urban Air 

Toxics\Aldehyde Data\Carbonyl Data Review.  Print out this form to record answers and provide 
comments where applicable.     

3. Save this file in the current run folder on the P-drive that is currently under review. 
4. Answer the Level 1 reviewer questions in document number DAQ-03-013 (UAT and PAMS Carbonyl 

Sampling and Analysis Data Level 1/Level 2 Review Checklist). 
5. For all questions answered no provide a comment with sample identification or failing compounds 

where appropriate, and/or provide a general comment explaining the situation in concise detail.   
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6.2 Peer/Level 2 Carbonyl Sampling and Analysis Data Review 
The Level 2 reviewer should receive notification from the primary analysist or Level 1 reviewer to start 
the Level 2 data review process.   

1. Open the review checklist already saved by the primary analysist.  The review checklist is in the 
current run folder under review on the p-drive.   

2. Answer the questions to verify the entries made by the primary analyst are correct and agree with 
QA requirements and to verify imbedded calculations are correct and referencing the correct cells.  

3. For all questions answered no provide a comment with sample identification or failing compounds 
where appropriate, and/or provide a general comment explaining the situation in concise detail. 

4. If error/typos are found during the Level 2 review, coordinate corrections with the primary analyst 
before approving the results for Level 3 validation.   

7.0 CARBONYL FILE MANAGEMENT 

7.1 UHPLC Instrument Files  
UHPLC instrument files such as chromatograms and results, calibrations, amount summaries, and 
sequences are stored on the UHPLC instrument computer in appropriately named file folders using a 
date hierarchy naming system established by the primary analyst.   

Additionally, these files are stored electronically on external USB storage devices and on internal 
network drives.  See Sections 5.5.1 and 5.5.2 for more details on UHPLC instrument file naming and 
storage conventions. 

7.2 Sample Information Forms, Chain of Custody Forms, and Extraction Manifold Worksheets 
The hard copies of SIFs, COC forms, and Extraction Manifold Worksheets for the current analytical run 
must be saved in the hard copy of the current run folder under review.  Additionally, electronic scans of 
the SIFs and Extraction Manifold Worksheets must be stored in the current analysis run folder under 
review on the P-drive. 

7.3 Standard Dilution Checklist 
This document is named “DAQ-03-017 Carbonyl Calibration and QC Standard Dilutions Checklist” and 
can be found here: 

P:\Toxics\Urban Air Toxics\Aldehyde Data\Carbonyl Standard Dilution Chart 

The primary analyst may print several copies to keep in a drawer in the extraction lab room.  Filled out 
copies of these forms are stored with the hard copy run folder and a scanned copy of the filled-out form 
is stored in the electronic copy of the run folder stored on the P-drive.   

If changes to this document are needed due to a change in calibration curve concentrations levels or a 
change to stock standard concentrations, or changes to spiking levels, the document will be saved with 
the same name as quoted above, but with “_revision 1” added to end of file name.  The revision number 
is in the top left corner of the excel file will need to be changed to match the new revision number.   
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Using the file name example given above, the new file would now be named: “DAQ-03-017 Carbonyl 
Calibration and QC Standard Dilutions Checklist_revision 1” and stored in the same location mapped 
above.     

7.4 Level 1 and Level 2 Data Review Checklists 
The data review checklist is named “DAQ-03-013 UAT and PAMS Carbonyl Sampling and Analysis Data 
Review Checklist” and stored here: 

P:\Toxics\Urban Air Toxics\Aldehyde Data\Carbonyl Data Review 

This document is printed and filled out with handwritten entries made by the self and peer reviewer.  
Once the data have been reviewed and approved by the level 2 reviewer, the handwritten copy of the 
data review checklist must be saved in the hard copy of the analysis folder under review.  Additionally, 
scan the completed review checklist and store the scan in the electronic copy of the current run folder 
under review located on the P-drive. 

If changes are need to the questions and/or documents listed in the form, the form is saved in the same 
location as mapped above and named DAQ-03-013 UAT and PAMS Carbonyl Sampling and Analysis 
Data Review Checklist_Revision 1. 

7.5 Carbonyl Master Spreadsheet 
The Carbonyl Master Spreadsheet is named DAQ-03-012 UAT and PAMS Carbonyl Master Spreadsheet.  
The template is located here:  

P:\Toxics\Urban Air Toxics\Aldehyde Data\Carbonyl Master Spreadsheet 

The primary analyst will save this file with the current calendar year in the file name.  If creating the 
master spreadsheet for calendar year 2021, name the file: “2021_DAQ 03-012 UAT and PAMS Carbonyl 
Master Spreadsheet and save this file in the current year’s data folder located here: 

P:\Toxics\Urban Air Toxics\Aldehyde Data 

This spreadsheet is used to track critical sampling and analysis data collected during the 2021 calendar 
year.   

If any part of the form headers or column names change or if columns are added, the above file example 
is saved as: “2021_DAQ 03-012 UAT and PAMS Carbonyl Master Spreadsheet_revision 1” and saved in 
the same location on the P-drive.   

7.6 Tracking Chart 
The Carbonyl tracking chart is used by the analyst and lab staff to keep track of cartridge shipping and 
receiving.  It provides a reference guide for scheduling cartridge prep and extractions.  This file is stored 
on the P-drive: P:/Toxics/Urban Air Toxics/VOC Current Year Data/Tracking Chart UAT VOC & 
Aldehyde 

7.7 QA Summary Report 
This report is named “DAQ-03-16 UAT and PAMS QA Summary Report” and is stored here: 
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P:\Toxics\Urban Air Toxics\Aldehyde Data\Carbonyl Data Review.  The primary analyst will open this 
file and save it with the following name DAQ-03-16 UAT and PAMS QA Summary Report_MMDDYY 
where the MMDDYY represents the current run folder to which the QA Summary Report applies.   

For example, if the QA summary report is for the 030521_Aldehyde Run_UV run folder; the QA 
Summary report will be named “DAQ-03-16 UAT and PAMS QA Summary Report_030521” and stored 
in the 030521_Aldehyde Run_UV run folder on the P-drive.  

See Section 9.5 of this SOP for information on how to document errors found on the QA Summary 
Report.  

If any part of the QA Summary Report headers, worksheets, or column names change or if columns are 
added, the above file example is saved as: “DAQ 03-016 UAT and PAMS QA Summary Report_revision 
1” and saved here: P:\Toxics\Urban Air Toxics\Aldehyde Data\Carbonyl Data Review. 

8.0 QUALITY ASSURANCE FILES AND DATA HANDLING 

8.1 Quarterly Pipette and Balance Verification 
Quarterly pipette and balance verification worksheets (as discussed in the section 3.4.1 and 3.4.2) 
records have been entered into the pipette verification worksheet located on internal network drives: 
P:/Toxics/Urban Air toxics/Aldehyde data/Balance and Pipette Checks. Hard copies are stored in the 
folder in the designated file cabinet.  

8.2 Certificate of Analysis Storage 
Certificate of analysis of Carbonyl cartridges, solvent (Acetonitrile) and Standards used for the carbonyl 
analysis are stored in a designated file cabinet in the RCL building.  

8.3 Carbonyl Extraction Logbook 
This Extraction logbook (Logbook# EXT-XX) will document the analytical work done in the extraction lab 
such as extraction, preparation of mobile phases, preparation of calibration curve, and quarterly 
verification of the analytical balance and mechanical pipettes. 

8.4 Carbonyl Instrument Logbook 
This instrument logbook (Logbook# Inst-XX) will document analysis of carbonyl samples on the UHPLC-
UV-MS, calibration and check standard used for the analysis, any maintenance or troubleshooting for 
the UHPLC-UV-MS. 

8.5 Monthly UHPLC Instrument Data Backup 
At the conclusion of each month all data must be copied to the external hard drive for data backup and 
archival.   

9.0 TROUBLESHOOTING AND CORRECTIVE ACTIONS 
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This section of the SOP describes the troubleshooting and corrective actions taken whenever there is an 
issue with the instrument or its supporting equipment, failing QC checks, and documenting errors found 
during the data review process, etc. 

9.1 Troubleshooting and Corrective Actions for UHPLC 
Please see Table 4 below for a description of troubleshooting and corrective actions of the UHPLC 
Instrument.  The UHPLC system and equipment modules are serviced yearly with basic preventative 
maintenance performed by certified technicians from Unity Lab Services.  The UHPLC and its 
components are under annual service contracts from Unity Lab Services which also provides for quick 
repair in the event non-consumable UHPLC parts break or malfunction.  Thermo Fisher and Unity Lab 
Services provide technical support via phone for assistance with UHPLC system troubleshooting that 
may be repaired by the operator and may not require an onsite visit by a certified technician.   

Issue Possible Cause Possible Solution 

High backpressure 
 
 

-Plugged inlet frit on column 
-Plugged frit in inline filter 
-Column blockage (chemical 
contamination) 

-Backflush column 
-Inspect frits in filters and replace as 
necessary 
-Clean column with solvent or replace 
column if irreversible 

Fluctuating pressure -Bubble in pump 
-Leaking check valve or seals 

- Check for the bubble in the line; degas 
the Mobile phase 
- Replace or clean check valves; replace 
pump seals; 

Peak tailing Column void 

Run in reverse direction; if poor peak 
shapes or peak doublets are seen for all 
peaks, a column void may be present; 
discard column. 

Peak fronting Channeling in column Replace column 

Extra peaks, or ‘ghost’ 
peaks System contamination 

Inject the sample solvent (ACN_Blank) 
injection to ensure that there is nothing 
in the sample solvent that contributes 
to the issue 

Retention time shifts -The column is getting old 
-Change in flow rate 

-Replace Column 
-Check flow rate 

Drifting baseline, 
Baseline Noise 

-Look to detector lamp or flow 
cell. 
-Occasional sharp spikes - 
external electrical interference 
-Periodic - pump pulses 
-Random - contamination build-
up 

-Replace if necessary 
-Use voltage stabilizer/constant voltage 
power supply for LC system 
-Service or replace pulse damper 
-purge air from pump 
-clean or replace check valves 
-degas mobile phase. 
-Flush or backflush column 
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Issue Possible Cause Possible Solution 

Poor Recovery 

-Damage syringe and syringe 
valve 
-Poor alignment in auto sampler 
injection port  
-Bad Injector 

-Replace syringe if necessary 
 
-Realign the auto sampler injection port 
 
-Replace injector 

Table 4: Troubleshooting and corrective actions of the UHPLC Instrument.   

 

9.2 Troubleshooting and Corrective Actions for Balance and Pipette Checks 
1. Analytical balance and pipette equipment must be verified quarterly, and pass acceptance criteria.   
2. If a balance or pipette check fails acceptance criteria, confirm the failing condition by performing a 

second verification check.   
3. If two consecutive balance and/or pipette verification checks fail acceptance criteria the equipment 

must be repaired and or recalibrated where applicable.  If the equipment is used while under this 
failing condition all analysis results must be minimally qualified “QX” back to the most recent 
expiration of a passing verification check and continue until the equipment is repaired, replaced, or 
recalibrated. A subsequent verification check is required for recalibrated or new equipment. 

4. If there is an instance of a past due quarterly verification, perform a verification as soon as possible 
according to steps in Section 3.4.1 and 3.4.2.   

5. If by any chance the pipette is dropped, perform a pipette verification check.  The pipette must pass 
acceptance criteria before the next use. 

6. If the balance is moved or bumped out of place, re-position the balance, re-level the balance, and 
perform a balance verification check.  The balance must past acceptance criteria before next use.   

9.3 Troubleshooting and Corrective Actions for Sampling Data 
1. As mentioned in section 5.2, sample volume should be within 1240L to 1650L for UAT samples and 

414L to 550L for PAMS.  Flow should be 0.9 to 1.1 L/min for both PAMS and UAT samples.  If the 
total volume or flow are not within acceptable range, the sample results must be qualified “W” 
before reporting to AQS.  Add a comment noting the flow or volume failure on the carbonyl 
cartridge SIF if the site operator has not already provided a flow or volume comment on the SIF.   

2. If sample collection has been interrupted for more than one hour during the collection period due to 
a power outage or due to weather, a makeup sample needs to be arranged. 

3. If there is any instance of spilling sample extract before bringing to 5mL volume and mixing, the 
sample needs to be voided and a makeup sample needs to be arranged.  A comment should be 
added to the extraction manifold worksheet and extraction lab logbook summarizing the issue.  If 
the extract is filled to the 5mL mark and mixed and then is spilled, some of the extract may be saved 
for analysis.  In this case note the issue on the extraction manifold worksheet and provide a 
comment in the master spreadsheet. 

4. Makeup samples need to be arranged within 30 days of the original sample date and within the 
same calendar year for UAT samples whereas for PAMS make up samples should be within two 
weeks from the originally scheduled collection date and collected within PAMS season (June 1 to 
August 31). 
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9.4 Troubleshooting and Corrective Actions for Carbonyl cartridges 
When doing the carbonyl cartridges lot blank test, the following compounds must meet concentrations 
and acceptance limits before field use: Formaldehyde ≤ 0.03 µg/mL; and all other compounds ≤ 0.02 
µg/mL to pass.  If Formaldehyde and/or Acetaldehyde do not meet acceptance limits, the lot must be 
disqualified for field use.  The failing lot of cartridges should be returned to the manufacturer for 
replacement if possible.   

9.5 Troubleshooting and Corrective Actions for Data Review Process 
Once the data processing has been completed by the analyst, Data needs to be verified by a Level 1 and 
Level 2 data reviewer.  Errors found during the review process are documented in the Level 1/Level 2 
Data Review Checklist, QA Summary Report, and master spreadsheet.  Errors corrected in the master 
spreadsheet and QA Summary report must be document as follows: 

• Go to cell containing the error, remove the error and enter the correct information.  Right click 
on the same cell and select add comment.  Document the error in the popup comment box, the 
comment must include the original data and briefly explain the correction.   

• The analyst can also document the correction in the comment column on the master 
spreadsheet or the comment section in the QA Summary Report.   
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Appendix A – Pipette Verification Worksheet  
 

 

  

Make= Room Temp (°C) Document# DAQ-03-014
Serial Number= Pressure (kPA) Version 0.0

Date Performed= Barometer SN= Effective Date 6/1/2021
Liquid Used=

Test #
Balance 

Reading (g)
Weighing 
Mass(mg) Z factor

Low Settting 
Volume(uL)

Balance Reading 
(g)

Weighing 
Mass(mg) Z factor

High Setting 
Volume(uL)

1 0.0000 0.0000 0.0000 0.0000
2 0.0000 0.0000 0.0000 0.0000
3 0.0000 0.0000 0.0000 0.0000
4 0.0000 0.0000 0.0000 0.0000
5 0.0000 0.0000 0.0000 0.0000

MEAN 0.0000 MEAN 0.0000
STDEV 0.0000 STDEV 0.0000
Accuracy #DIV/0! Accuracy #DIV/0!
CV #DIV/0! CV #DIV/0!

Accuracy 8.00% Accuracy 2.00%
CV 3.00% CV 1.00%

Pipette Verification Worksheet 

Comments: 

Level 2 Review By:

Balance S/N

Expiration Date:

DocuSign Envelope ID: 727D24B4-9874-4782-8CE2-9445D3E451B4



  DAQ-03-004.2 
  Revision 0 
  06/29/2021 

Page 32 of 45 

 

Appendix B – Balance Verification Worksheet 
 

 

  

Balance Make/Model= Document# DAQ-03-015
Balance Serial Number= Version 0.0

Weight Make/Model= Effective Date 6/1/2021
Weight Serial Number=

Room Temp (°C)= Date of Verification=
Pressure (kPA)= Analyst Initials=
Barometer SN=

Nominal Weight Nominal Weight Unit Measured Weight (g) Accuracy (% Diff)
5 mg 100.00%

200 mg 100.00%
500 mg 100.00%

2 g 100.00%
Accuracy 2%

Balance Verification Worksheet

Comment:

Level 2 Review By:
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Appendix C – Carbonyl Cartridge Sample Information Form 
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Appendix D – Carbonyl Cartridge Chain of Custody Form 
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Appendix E – UAT Carbonyl Samples Tracking Chart 
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Appendix F – PAMS Carbonyl Samples Tracking Chart 
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Appendix G – Aldehyde Extraction Manifold Work Sheet 
 

 

  

Port # Port #
1 7
2 8
3 9
4 10
5 11
6 12

1.5 mL autosampler vials
Autosampler caps with septa

Syringe filters

Extraction Material Lot #s
Acetonitrile

4mL clear storage vials

Aldehyde Extraction Manifold Worksheet
Analyst

Extraction Date
Cartridge Sample Dates

Sample ID Sample ID

COMMENTS:
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Appendix H – Extraction Manifold Map 
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Appendix I – MS Detector Real-Time Scan Settings 
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Appendix J – Calibration and QC Standard Dilution Chart 
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Appendix K – Example Sequence for UV Detector Analysis 
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Appendix L – Example Sequence for MS Detector Analysis 
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Appendix M – Unedited Chromatogram 
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Appendix N – Edited Chromatogram 
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Appendix O – Example Certificate of Analysis for Carbonyl Standard 
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